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IMPORTANTE: QUESTO TESTO RICHIEDE LA SUA ATTENZIONE E LETTURA

L’informazione contenuta in questo documento è proprietà di CYPE Ingenieros S.A. e non può essere né riprodotta né trasferita in nessun
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CYPE Ingenieros S.A. L’infrazione dei diritti di proprietà intellettuale può rappresentare un reato (art. 270 e seguenti del Codice Penale).

Questo documento e l’informazione in esso contenuta sono parte integrante della documentazione che accompagna la Licenza d’Uso
dei programmi informatici di CYPE Ingenieros S.A. e sono da essa inseparabili. Pertanto essa è protetta dalle stesse leggi e dagli stessi
diritti.

Non dimentichi che dovrà leggere, comprendere e accettare il Contratto di Licenza d’Uso del software di cui fa parte questa documenta-
zione prima di utilizzare qualsiasi componente del prodotto. Se NON accetta i termini del Contratto di Licenza d’Uso, restituisca immedia-
tamente il software e tutti gli elementi che lo accompagnano al luogo in cui lo ha acquistato per ottenere un rimborso completo.

Questo manuale corrisponde alla versione del software denominata Muri a mensola in calcestruzzo armato da CYPE Ingenieros S.A.
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to libro senza previo avviso. Il software che accompagna questo documento può essere sottoposto a modifiche senza previo avviso.

CYPE Ingenieros S.A. dispone di altri servizi tra cui si trova il servizio di Aggiornamenti, che le consentirà di acquistare le ultime versioni
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Presentazione

Muri a mensola in calcestruzzo armato è un programma concepito per il dimensionamento e per la
verifica di muri in calcestruzzo armato che lavorano a mensola per il contenimento di terreni. Esegue il predimen-
sionamento automatico della geometria, il calcolo dell’armatura del muro e il dimensionamento geometrico del-
le armature del plinto del muro.

Contempla differenti strati di terreno, livelli freatici, strati rocciosi e qualsiasi tipo di carico all’estradosso
e all’intradosso.

È possibile definire le differenti fasi costruttive. Consente inoltre di eseguire il calcolo sismico del muro.

Si possono ottenere elenchi di tutti i dati inseriti, il disegno delle fasi, i risultati derivanti dal calcolo, i dia-
grammi delle azioni interne e delle deformazioni per ciascuna fase o per l’insieme di fasi selezionato, e viste
esplose dell’armatura.

Dispone inoltre di un semplice assistente per la generazione della geometria del muro e dei carichi
agenti su di esso.

Gli elenchi possono essere inviati alla stampante (con anteprima di stampa opzionale, impostazione di
pagina, ecc.) o esportati in file HTML, PDF, RTF, TXT e DOCX.

I disegni esecutivi possono essere inviati alla stampante, esportati in formato DXF o DWG o a qualsiasi
periferica grafica.

Muri a mensola in calcestruzzo armato - Manuale dell’utente 5
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1. Generalità

1.1. Help su schermo
I programmi di CYPE Ingenieros dispongono sullo scher-
mo di strumenti di help, mediante i quali l’utente può diret-
tamente ottenere le informazioni necessarie relative al fun-
zionamento dei menu, dei riquadri di dialogo e delle opzio-
ni in essi contenuti.

È possibile accedere all’help in quattro modi distinti:

1.1.1. Tasto F1

Per consultare l’help inerente a un’opzione del menu, biso-
gna aprire il menu stesso, posizionarsi sull’opzione in que-
stione e, senza eseguirla, premere il tasto F1.

1.1.2. Icona con il simbolo del punto interrogativo

Nella barra del titolo della finestra principale di ciascun pro-
gramma è presente un’icona con il simbolo del punto inter-
rogativo . Si può ottenere help specifico relativo a un’op-
zione del programma cliccando su tale icona, aprendo il
menu contenente l’opzione in questione e cliccando su
quest’ultima. Compare una finestra con l’informazione ri-
chiesta (analoga a quella che si visualizza premendo il ta-
sto F1).

L’help può essere disattivato in tre modi differenti: clic-
cando il tasto destro del mouse, cliccando sull’icona con il
simbolo del punto interrogativo, o premendo il tasto Esc.

È inoltre possibile ottenere help direttamente dalle icone
contenute nella barra degli strumenti; a tale scopo è
necessario cliccare sull’icona con il simbolo del punto inter-
rogativo . A questo punto i bordi delle icone contenenti
l’informazione desiderata si colorano di blu. In seguito,
bisogna cliccare sull’icona di cui si desidera consultare
l’help.

Infine, nella barra del titolo dei riquadri di dialogo che si
aprono al momento di eseguire alcune opzioni del pro-
gramma, si trova un’icona con il simbolo del punto inter-
rogativo ; dopo aver cliccato su di essa, i bordi delle
opzioni o delle parti dei riquadri di dialogo che dispongono
dell’help si colorano di blu. Si deve cliccare sull’opzione di
cui si desidera consultare l’help.

1.1.3. Icona a forma di libro

Nella barra del titolo di alcuni riquadri di dialogo compare
un’icona a forma di libro aperto che fornisce informa-
zioni generali circa il riquadro di dialogo in questione.

1.1.4. Guida rapida

Le informazioni mostrate usando il tasto F1 relative alle op-
zioni del menu possono essere consultate e stampate me-
diante l’opzione Help > Guida rapida. Esse sono quelle
corrispondenti alle opzioni ubicate all’interno delle cor-
rispondenti linguette dello schermo.

In questa guida non sono contenuti gli help dei riquadri di
dialogo.
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2.1. Parti del muro
Si considera che il muro sia costituito da più parti differenti:

• Muro. Corpo del muro dalla base fino alla sommità.

• Terreni. Riporti di terra (formati da uno o più strati) al-
l’estradosso e all’intradosso, con presenza opzionale
di strato roccioso e/o livello freatico.

• Fondazione. Plinto continuo al di sotto del muro; può
presentare un dente per incrementare la sua stabilità
nei confronti dello scivolamento/scorrimento.

2.2. Geometria
Nel seguito si illustra un elenco dei termini usati nel pro-
gramma:

• Estradosso. Lato del muro in contatto con il terreno.

• Intradosso. Lato libero del muro, sebbene in certi casi
possa essere in contatto con una parte del terreno.

• Altezza. Distanza verticale tra la base e la sommità del
muro.

• Spessore superiore. Larghezza del muro in cor-
rispondenza della sua sommità.

• Spessore inferiore. Larghezza del muro in corrispon-
denza della sua base (deve essere maggiore o uguale
allo spessore superiore). È possibile definire muri con
spessore variabile. Nel momento in cui si definisce la
geometria del muro, è necessario fissare i suoi spes-
sori rispetto all’estradosso (opzione “livellamento del
muro all’estradosso”), all’intradosso (opzione “livella-
mento del muro all’intradosso”), e al piano verticale

medio (opzione “senza livellamento del muro”; in tal ca-
so si misurano gli spessori a partire dall’asse verticale
del muro rispetto a ciascun suo lato. La loro somma
coincide con lo spessore totale).

• Gradini. Tratti in cui è possibile suddividere il corpo del
muro; generalmente presentano un brusco cambio di
spessore. Si usano al posto dei muri a spessore varia-
bile per agevolare l’inserimento delle casseforme. Si
possono realizzare su un lato o su entrambi i lati del
muro; in corrispondenza di un gradino, l’armatura si in-
terrompe piegandosi e sovrapponendosi con quella del
tratto superiore.

• Sovrapposizioni. L’armatura verticale può essere sud-
divisa in più tratti sovrapposti, di cui si devono definire il
numero e l’altezza. Suddividere l’armatura in più tratti
sovrapposti è utile in muri di altezza elevata a spessore
costante o variabile, in cui disporre armatura lungo tutto
il loro sviluppo verticale risulta complesso e pericoloso,
oppure quando le casseforme non presentano altezza
sufficiente, rendendo consigliabile la loro esecuzione
per tratti. L’altezza comune delle casseforme si aggira
intorno a 2.50 m; per costruire un muro di altezza pari a
7 m, pertanto, bisogna creare tre fasi, rispettivamente,
di 2.50 m, 2.50 m e 2 m ciascuna.

Il programma esegue il calcolo di plinti continui in calce-
struzzo armato al di sotto del muro, la cui altezza è costan-
te; si possono definire tre tipi di plinti all’interno del pro-
gramma:

• Con aggetto unicamente a sinistra

• Con aggetto unicamente a destra

• Con aggetto in corrispondenza di entrambi i lati

2. Memoria di calcolo
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È inoltre possibile inserire un dente in ciascun tipo di plinto
contemplato dal programma.

2.3. Carichi
La seguente figura illustra lo stato generale dei carichi
agenti su di un muro:

Fig. 2.1

Dal momento che è possibile definire riporti su entrambi i
lati del muro, è evidente che per ciascun stato o situazione
considerata esiste un lato su cui la spinta è maggiore ri-
spetto all’altro. Quest’ultima produce un’azione sul muro,
mentre sul lato in corrispondenza del quale agisce la spin-
ta minore nasce una reazione, dato che il muro tende a
spostarsi verso questo lato, comprimendolo.

Si sviluppano quindi i tipi di spinte elencate nel seguito:

• Spinta attiva. Il terreno esercita una spinta sul muro,
comportando la nascita, nella direzione della spinta
stessa, di deformazioni sufficienti per portare il terreno
al suo stato di rottura. Il caso è comune quando si ap-
plica un’azione sul terreno.

• Spinta a riposo. Il terreno esercita una spinta sul muro
senza che quest’ultimo subisca deformazioni (si consi-
derano nulle o trascurabili). È il caso di muri che pre-
sentano una restrizione applicata allo spostamento in
corrispondenza della loro sommità, dovuta alla presen-
za di altri elementi, quali, ad esempio, muri di piani in-
terrati che sostengono un solaio in corrispondenza del-
la loro sommità. Il valore di tale spinta è maggiore di
quello della spinta attiva. Si consiglia di non utilizzare la
spinta a riposo nel programma; in casi particolari, tut-
tavia, è possibile simulare la restrizione in sommità
attraverso un carico orizzontale applicato sulla stessa,
nel momento in cui l’utente si sia previamente assicurato
che tale carico annulli qualsiasi spostamento in cor-
rispondenza della sommità.

• Spinta passiva. Quando il muro si sposta contro il ter-
reno, quest’ultimo viene compresso e fornisce una rea-
zione. A seconda dello spostamento del muro e del tipo
di terreno, è possibile sviluppare una percentuale di
questa spinta passiva o la sua totalità (tuttavia, affinché
ciò si verifichi, si richiedono grandi deformazioni), a me-
no che il terreno sia molto rigido (elevato grado di com-
pattazione) o che sia presente uno strato roccioso. Ge-
neralmente, la spinta passiva non si sviluppa completa-
mente, per cui si raccomanda di considerare solamente
una percentuale della stessa. Il suo valore è molto mag-
giore di quello della spinta attiva; per tale motivo si con-
siglia di trattarla con prudenza.

A tale spinta si associa la definizione di ‘quota della
spinta passiva’, al di sotto della quale la stessa si consi-
dera, mentre al di sopra non si considera mai. Ad
esempio, la quota di partenza di un muro è pari a ‘0’ e,
analogamente, la quota della spinta passiva è ‘0’; se si
attiva una percentuale della spinta passiva essa agisce
solo ed esclusivamente sull’altezza del plinto. Se la
quota della spinta passiva aumenta, si può giungere a
una situazione in cui la risultante della spinta passiva
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sia maggiore della risultante della spinta attiva, il che
non è per niente logico.

Si raccomanda vivamente di consultare i diagrammi dei
tagli affinché ciò non si verifichi, o di definire la quota
della spinta passiva sempre al di sotto della quota di
partenza del muro.

• Senza spinte. Questa situazione consente al terreno
che reagisce di non sviluppare nessun tipo di spinta; si
considera il suo peso solo come componente verticale
agente sul plinto.

È possibile ottenere maggiori informazioni circa il calcolo di
queste spinte consultando l’opzione Help > Elementi di
sostegno - Calcolo delle spinte.

2.4. Risultati

2.4.1. Prospetto del muro

Il programma consente di consultare un elenco delle verifi-
che eseguite utilizzando le opzioni inerenti al dimensiona-
mento e alla verifica. A lato di ogni verifica si indica il para-
grafo o l’articolo corrispondente della norma secondo cui
la verifica in questione è stata condotta. Per quei casi in cui
non sia stato stabilito nessun criterio di verifica, si fa riferi-
mento ai criteri previsti dalle norme Spagnole relative al cal-
cestruzzo e a bibliografie di riconosciuto prestigio.

È molto importante quindi controllare l’elenco delle verifi-
che eseguite e i valori derivanti dal calcolo, che dovranno
poi essere confrontati con quelli contemplati dalla norma.

Si invita pertanto l’utente a consultare l’elenco in qualsiasi
momento in cui lo ritenga necessario e, nel caso in cui sor-
gano dubbi, ad analizzarlo dettagliatamente al fine di as-
sicurarsi che tutte le sezioni siano verificate.

Le verifiche eseguite dal programma sono:

2.4.1.1. Verifica a taglio alla base del muro

Si verifica che il taglio di calcolo in corrispondenza dell’in-
terfaccia muro-plinto sia minore di quello sopportato dalla
sezione in corrispondenza di tale punto, tenendo in consi-
derazione la sezione in calcestruzzo e l’acciaio disposto.

2.4.1.2. Spessore minimo

Si limita lo spessore minimo sulla base di quanto indicato
nella norma selezionata.

2.4.1.3. Rapporto geometrico minimo di armatura

Allo scopo di controllare qualsiasi fessurazione che può na-
scere a causa di deformazioni originate dagli effetti della
temperatura e del ritiro, si impongono dei valori minimi al
rapporto di armatura variabili a seconda della norma sele-
zionata.

2.4.1.4. Rapporto meccanico minimo di armatura

Si richiedono dei rapporti meccanici minimi per l’armatura
verticale affinché non nascano rotture fragili quando la se-
zione si fessura a causa delle azioni interne di flessocom-
pressione.

2.4.1.5. Rapporto geometrico massimo di armatura

Si stabilisce un valore massimo per il rapporto di armatura
verticale totale.

2.4.1.6. Interferro minimo

Per consentire un getto corretto si richiede un interferro mi-
nimo tra armature sulla base di quanto stabilito dalla nor-
ma.
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2.4.1.7. Interferro massimo

Si stabilisce questa limitazione affinché non esistano zone
prive di armatura. Si può considerare una condizione mini-
ma per poter parlare di ‘calcestruzzo armato’ e non di ‘cal-
cestruzzo non armato’.

2.4.1.8. Verifica a flessocompressione

La verifica di resistenza della sezione si esegue utilizzando
come legge costitutiva del calcestruzzo il diagramma ten-
sione-deformazione semplificato parabola-rettangolo, al fi-
ne di stabilire l’area in cui la sezione in calcestruzzo armato
va incontro a rottura a causa di azioni interne di flessocom-
pressione. La verifica a flessocompressione è implementa-
ta per tutte le norme di calcolo contemplate dal program-
ma, con le loro indicazioni relative all’integrazione delle ten-
sioni nella sezione e ai valori limitanti le deformazioni am-
missibili per i materiali costituenti la sezione (acciaio e cal-
cestruzzo).

Nell’eseguire la verifica a flessocompressione, bisogna
avere la precauzione di ancorare le armature allo scopo di
considerarle effettive nel calcolo. Inoltre, poiché le azioni
interne di flessocompressione agiscono contemporanea-
mente al taglio, si produce un’interazione tra queste azioni
interne. Tale fenomeno si tiene in considerazione traslando
il diagramma dei momenti flettenti di una quantità uguale
all’altezza utile della sezione nel verso più sfavorevole.

2.4.1.9. Verifica a taglio

La verifica di questo stato limite ultimo si esegue nello stes-
so modo di quella a flessocompressione. Non avendo di-
sposto armatura trasversale nella sezione, si considera uni-
camente il contributo fornito dal calcestruzzo alla resisten-
za a taglio, il cui valore si valuta a partire da un termine Vcu
ricavabile sperimentalmente. In genere, questo termine si
include all’interno della verifica del taglio dovuto a rottura

per trazione nell’anima della sezione. Nell’applicazione so-
no state considerate le distinte espressioni che consentono
di valutare Vcu a seconda della norma selezionata.

2.4.1.10. Verifica a fessurazione

Lo stato limite di fessurazione è uno stato limite di esercizio
che si verifica con lo scopo di controllare la nascita di fes-
sure nelle strutture in calcestruzzo. Nel caso di muri il con-
trollo della fessurazione è molto importante dal momento
che essa si produce in primo luogo nella faccia dell’estra-
dosso, zona che abitualmente non si può osservare a oc-
chio nudo e in cui è possibile che proliferi la corrosione del-
le armature. Si può verificare il deterioramento della strut-
tura senza apprezzare facilmente gli effetti negativi che na-
scono sul muro; si tratta di controllare le fessure originate
dalle azioni che agiscono direttamente sul muro (terreno,
livello freatico, sovraccarichi…), e non le fessure dovute al
ritiro e alla temperatura, già tenute in conto considerando i
valori geometrici minimi.

Per il calcolo dell’apertura limite delle fessure è stato segui-
to un processo semplificato in cui si considera flessione
semplice; attraverso di esso si ottengono risultati maggior-
mente a favore di sicurezza rispetto a quelli che si possono
ricavare considerando flessocompressione.

Per le distinte norme implementate nel programma si se-
gue il metodo generale di calcolo dell’apertura delle fes-
sure e si paragonano i risultati ottenuti con i limiti imposti da
ciascuna norma, a seconda del tipo di esposizione o am-
biente in cui risulta ubicata la struttura. A differenza degli
stati limite ultimi di flessocompressione e taglio, in cui si
utilizzano le combinazioni di azioni corrispondenti agli stati
limite ultimi, nel caso della fessurazione si impiegano le
combinazioni di azioni corrispondenti alle azioni caratteristi-
che. Il programma calcola l’apertura caratteristica delle fes-
sure wk per tutte le ipotesi.
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Si ripete il calcolo in corrispondenza di quote differenti del
muro, analogamente a come si procede nelle verifiche a
flessocompressione e a taglio. Si assume il valore più sfa-
vorevole e si paragona con il valore dell’apertura della fes-
sura limite specificato da ogni norma. In questo modo, è
possibile verificare se si soddisfa o meno questo stato limi-
te di servizio.

2.4.1.11. Verifica delle lunghezze di sovrapposizione

Il calcolo delle lunghezze di sovrapposizione si esegue
conformemente a quanto previsto dalle differenti normative
implementate.

2.4.1.12. Verifica dell’ancoraggio dell’armatura base
in sommità

Il calcolo delle lunghezze di ancoraggio si conduce confor-
memente a quanto previsto dalle diverse normative imple-
mentate.

2.4.2. Plinto del muro

Il carico agente sul muro si converte in un diagramma di-
screto di carichi lungo il muro; è come convertire una risul-
tante in un diagramma di tensioni applicate lungo la base
del muro, discretizzata internamente in gradini dal pro-
gramma a seconda delle sue dimensioni.

Le verifiche eseguite dal programma sono:

2.4.2.1. Verifica di stabilità

Applicando le combinazioni corrispondenti relative allo sta-
to limite da verificare, si verifica che la risultante sia conte-
nuta all’interno del plinto e si calcola il coefficiente di sicu-
rezza al ribaltamento e allo scorrimento.

2.4.2.2. Tensioni sul terreno

Si ipotizza una distribuzione di deformazioni piana per il
plinto; in funzione delle azioni interne, si ottengono pertanto
diagrammi trapezoidali di tensioni sul terreno. Non si am-
mettono trazioni, per cui, quando la risultante esce dal noc-
ciolo centrale d’inerzia, compaiono zone prive di tensione.
La risultante deve cadere all’interno del plinto, altrimenti
l’equilibrio non è rispettato (si considera il peso proprio del
plinto). Il programma verifica che la tensione principale non
ecceda quella ammissibile del terreno e che la tensione
massima in corrispondenza dei bordi non ecceda quella
principale, in termini percentuali, di un certo valore.

2.4.2.3. Altezza minima

Il programma verifica l’altezza minima specificata dalla nor-
ma selezionata.

2.4.2.4. Lunghezze di ancoraggio

Si verifica l’ancoraggio delle armature ai loro estremi,
realizzando pieghe dove necessario.

2.4.2.5. Diametro minimo delle barre

Si verifica che il diametro sia almeno il minimo stabilito dal-
la norma.
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2.4.2.6. Interferro massimo

Si limita il valore dell’interferro massimo allo scopo di evita-
re la nascita di zone prive di armatura. Si può considerare
una condizione minima per poter parlare di ‘calcestruzzo
armato’ e non di ‘calcestruzzo non armato’.

2.4.2.7. Interferro minimo

Si verificano gli interferri minimi sulla base di quanto stabili-
to dalla norma.

2.4.2.8. Flessione nel plinto

La flessione si verifica su di una sezione di riferimento si-
tuata a una distanza pari a 0.15 volte la larghezza del muro
verso l’interno del muro stesso. Il dimensionamento a fles-
sione obbliga a realizzare muri con un’altezza tale da non
rendere necessaria la disposizione di armatura a compres-
sione. Nel caso in cui compaiano trazioni, nella parte supe-
riore del plinto si dispone armatura superiore.

2.4.2.9. Taglio

La verifica a taglio si esegue su di una sezione di riferimen-
to situata a una distanza uguale all’altezza utile dai bordi
del muro. Il dimensionamento a taglio obbliga a realizzare
muri con un’altezza tale da non rendere necessaria la di-
sposizione di armatura trasversale.

2.4.2.10. Rapporto geometrico e meccanico di arma-
tura

Si verifica il soddisfacimento dei rapporti meccanici e geo-
metrici minimi specificati dalla norma.

2.4.2.11. Dimensionamento della geometria

Il programma consente di dimensionare la geometria del
muro e del plinto.

Il criterio di dimensionamento del muro è il seguente:

• Spessore superiore = 0.25 (m)

• Spessore inferiore = 0.11 × Altezza equivalente del ter-
reno (m). Il programma calcola il momento alla base
del muro prodotto dal terreno all’estradosso e dai cari-
chi che possono essere presenti sul terreno e in som-
mità del muro. Sulla base di tale momento si calcola
un’altezza di terreno equivalente, cioè, quella che pro-
durrebbe lo stesso momento calcolato in precedenza.

Il criterio di dimensionamento per il plinto è il seguente:

• Altezza = maggiore tra i seguenti valori:

a) 0.10 × Altezza equivalente del terreno (m)
b) 0.50 × Sbalzo massimo (se è stata selezionata l’op-

zione Progetto > Opzioni > linguetta Plinto >
Dimensionare altezza come > Rigido).

c) 0.33 × Sbalzo massimo (se è stata selezionata l’op-
zione Progetto > Opzioni > linguetta Plinto >
Dimensionare altezza come > Flessibile).

• Sbalzi. Il dimensionamento degli sbalzi si esegue in mo-
do tale che ci sia equilibrio nel plinto (ribaltamento e
scorrimento) e che non si ecceda la tensione ammissibile
del terreno.
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3.1. Assistente
Quando si crea un nuovo progetto il programma offre la
possibilità di usufruire di un assistente, la cui funzione è
quella di creare i dati necessari a descrivere il muro sulla
base di un numero ridotto di parametri inseriti dall’utente in
modo sequenziale. Tramite l’assistente è possibile eseguire
il predimensionamento della geometria e la generazione dei
carichi. Qualsiasi dato inserito può essere controllato e/o
modificato una volta generato il progetto.

Fig. 3.1

Fig. 3.2

Fig. 3.3

3.2. Elenchi
Gli elenchi si ottengono mediante l’opzione File > Stam-
pare > Elenchi del progetto o, alternativamente, clic-
cando sull’icona nell’angolo superiore destro della
barra degli strumenti.

Si possono inviare alla stampante (con anteprima di stam-
pa opzionale, impostazione di pagina, ecc.) o esportare in
file HTML, PDF, RTF, TXT e DOCX.

3. Descrizione del programma
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Fig. 3.4

3.3. Disegni esecutivi
I disegni esecutivi si ottengono mediante l’opzione File >
Stampare > Disegni esecutivi del progetto o, alternati-
vamente, cliccando sull’icona nell’angolo superiore
destro della barra degli strumenti.

È possibile realizzare le seguenti operazioni per originare i
disegni esecutivi:

• La finestra Selezione di disegni esecutivi consente
di aggiungere uno o più disegni esecutivi da stampare
contemporaneamente e di specificare la periferica di
output (stampante, plotter, DXF o DWG), di selezionare
un cartiglio (di CYPE o qualsiasi altro definito dall’uten-
te) e di configurare i layer.

Fig. 3.5

• È possibile configurare in ciascun disegno esecutivo gli
elementi da stampare, con la possibilità di includere
dettagli importati in precedenza dall’utente.

Fig. 3.6
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• Modificare la posizione di testi:

Fig. 3.7

• Disporre nuovamente gli oggetti all’interno dello stesso
disegno esecutivo o inserirli in un altro.

Fig. 3.8
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